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New and Changed Information
The following sections provide the descriptions of various features that have been added/modified in this release:

Documentation Improvement and Usability

Diameter Agent configuration
Configuration steps for the Diameter Agent have been documented in the “Diameter Configuration” chapter of the CPS 
Mobile Configuration Guide.

Scheduled Events Plug-in configuration
Instructions for enabling and configuring the Scheduled Events Plug-in have been documented in the “Plug-in 
Configuration” chapters in the CPS Mobile Configuration Guide and CPS Wi-Fi Configuration Guide.

Service Configuration Objects
Gx, Gy, Rx, Sd, and Sy service configuration objects have been documented in the new “Service Configuration Objects” 
chapter in the CPS Mobile Configuration Guide:
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Use Case Initiators
A number of commonly used use case initiators have been documented in the “Services” chapter of the CPS Mobile 
Configuration Guide:

Clearing Procedures
Instructions for clearing SNMP traps and alarms have been included in Clearing Procedures chapter of CPS SNMP, 
Alarms and Clearing Procedures Guide.

Name Change
The title of the following CPS guide has been updated for this and later releases:

Control Center Usability Improvement

CRD Table Snapshot and Revert 
You can create a snapshot of CRD tables on the system. The created snapshot will contain CRD table data, policy 
configuration and checksum information for all CRD tables.

You can revert the CRD data to a specific snapshot.

For more information, see CPS CCI Guide for Full Privilege Administrators.

Improved CRD Table Readability
A key symbol and arrows are provided to each column in the Custom Reference Data table to enable the user to 
distinguish among keys, input columns, and output columns.

 A key symbol indicates a key column.

 A downward arrow indicates an input column.

 An upward arrow indicates an output column.

For more information, see CPS CCI Guide for Full Privilege Administrators.

Table 1 Guide Name Change

Old Title New Title

CPS_MOG SNMP and Alarms Guide CPS SNMP, Alarms and Clearing Procedures Guide
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New and Changed Information
Geographic Redundancy

UAPI Traffic Switching in Sync with Diameter Traffic
For GR deployments, a new configurable parameter STOP_UAPI=1 has been added in 
/etc/broadhop/mon_db_for_callmodel.conf file to switch off UAPI interfaces in sync with diameter traffic so that 
their traffic is on same site. 

 STOP_UAPI=1 switch-off UAPI interface when primary database is not available on this site

 STOP_UAPI=0 do not switch-off UAPI interface when primary database is not available on this site

When we recover GR site, we have to manually start UAPI interface (if it is disabled) by executing the following command 
as a root user on lb01 and lb02:

echo "enable frontend https-api" | socat stdio /tmp/haproxy

Mobile

Configurable RAN/NAS Cause Code based Bearer Handling
In case VoLTE setup fails, that is, the dedicated bearer creation fails with some RAN/NAS cause code, CPS now receives 
the rule failure report with a RAN/NAS cause code from PCEF. CPS can retry the dedicated bearer setup based on these 
RAN/NAS cause codes, so that the failure to create the dedicated bearer can be minimized.

For more information, see CPS Mobile Configuration Guide.

Consolidated Sh Connection across Multiple Sessions for the Same Subscriber
For multiple Gx sessions for the same subscriber, CPS now creates one Sh request for the first Gx session to fetch the 
subscribers profile from the SPR or HSS database. CPS temporarily stores this subscriber profile in the local CPS SPR 
cache. Now, for another Gx session for same subscriber, CPS queries the local CPS SPR database. If the subscriber 
profile is found, CPS uses this subscriber profile. If the profile is not found, CPS creates a new Sh request to the SPR or 
HSS database.

For more information, see CPS Mobile Configuration Guide. 

Expose Out of Credit and Restoration of Credit Event Triggers for Policy Evaluation
You can enable a trigger for Out of Credit (OOC) and Retrieval of Credit (ROC) events by configuring the Gx Out of Credit 
Retriever event in the session_action_mapping_gx CRD table. The configuration is used in conjunction with the other 
columns in the Session_Actions_Gx table in Control Center to derive the actions in the Session_Action output column.

For more information, see “OOC and ROC Policy CRD Event Trigger Configuration” in the “Diameter Configuration” 
chapter of the CPS Mobile Configuration Guide.

Expose the 3GPP Final Unit Indication for Policy Evaluation in Out of Credit Scenarios
CPS now supports 3GPP Final Unit Indication (FUI) feature for Gx policies.

CPS can now extract the Final Unit Action (FUA) and Filter IDs from an OUT_OF_CREDIT Event report and use that for 
policy decisions using Initiator Conditions or Customer Reference Data tables. 

The received FUA and Filter IDs are stored at Gx session level, and are overwritten on OOC and reset on ROC event 
trigger. Since the AVP values are stored in the session, they are available for all future evaluations too.
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Flow Description Source IP Evaluation Parameter Updates
The drop-down list for Flow Description Source Ip Evaluation under Rx Clients has been changed:

For more information, see CPS Mobile Configuration Guide.

Improved Rx Handling during Gx Pending Transaction Race Conditions
CPS now supports handling of Gx 3GPP Pending Transaction (as specified in 3GPP Rx 29.212 Release 12) on Gx with 
respect to the Rx interface.

For Gx messages (RAR) due to Rx triggers (AAR/STR), if the RAR is rejected with DIAMETER_PENDING_TRANSACTION 
(4144) error, CPS retires the Gx messages as per the current Pending Transaction feature implementation. No failure 
notifications are generated while the retry is in progress. Only after all attempts are exhausted, CPS notifies AF of failure 
to apply policy. 

Currently, only rule failures are reported (if Specific-Action INDICATION_OF_FAILED_RESOURCES_ALLOCATION (9) is 
subscribed).

NetLoc Access Support
CPS supports to send NetLoc-Access-Support AVP in Rx AAA or STA message based on the current IP-CAN-Type or 
the values of Rat-Type AVP and AN-Trusted AVP. This is in accordance with the section 4.4.6.7 of the 3GPP 29.214.

To enable this, Netloc Access Not Supported Configuration check box has been added under Rx Client.

Non-blocking CDR Generation
To avoid CDR write impact on Policy Engine threads, the CDR is now made non blocking. This enhancement does not 
impact live traffic and also results in higher response time for diameter calls.

For more information, see CPS Advanced Tuning Guide.

Policy Decisions Based on Specified Gx AVPs
CPS now supports extraction of AVPs from the diameter message. Once extracted, the AVPs are then available for use 
in Initiator Conditions or as key AVPs for CRD evaluation.

For more information, see CPS Mobile Configuration Guide.

Rx Custom Errors
CPS now enforces a unique AF-Charging-Identifier value across all Rx sessions within a given subscriber or network 
session (as specified in 3GPP Rx 29.214 Release 12). 

During an Rx session establishment, if there is already an Rx session (within the subscriber or network session) 
containing the same AF-Charging-Identifier value, CPS rejects the new Rx session with DUPLICATED_AF_SESSION 
(5064) experimental result code.

For more information, see CPS Mobile Configuration Guide.

Table 2 Flow Description Source Ip Evaluation

Older Option New Option

None None

Replace Src IP Replace with 'any'

Replace Src IP if 'any Replace with UE IP
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Time Usage Monitoring
CPS now supports time based Gx usage monitoring control and reporting based on as 3GPP 29.212 Rel 12 Sections 
4.5.16 and 4.5.17. 

It supports the ability to configure a Gx usage monitoring key as volume, time or both.

Balance: This feature reuses the time related units like seconds, minutes, hours, and so on for balance that are already 
provided by Account Balance Templates. No new threshold types have been added. Only % thresholds can be used with 
Time balances.

Use Case Template: A new UsageMonitoringKeyDual service configuration has been added to support the time usage 
monitoring (The existing UsageMonitoringKey is still supported for Volume Usage monitoring). This new option provides 
a way to configure usage monitoring for both time and volume (independently as well as together under single monitoring 
key). To monitor usage under one key for Volume and Time, both the balance codes need to be provided in the Service 
Configuration. For independent monitoring, only the relevant type of fields can be set. For example, for only Volume 
monitoring, fields related to time monitoring can be left blank/null and vice versa. Multiple instances of 
UsageMonitoringKeyDual can also be included in the service configuration each corresponding to a unique monitoring 
key. 

Gx Message Handling: The following new AVPs are now supported under this feature:

 CC-Time (within Granted-Service-Unit and Used-Service-Unit)

 Quota-Consumption-Time (within Usage-Monitoring-Information)

For more information, see CPS Mobile Configuration Guide.

Usage Reporting over Sd
CPS now eliminates the need for TDF to send Application Stop in Sd CCR-U to PCRF on Validity-Time expiry.

TDF only sends an Application Start in the CCR-U along with the CC-Time AVP under the Granted-Service-Unit AVP 
within the Sponsored-Connectivity-Data AVP to communicate the Validity-Time of the rule to PCRF.

CPS stores this CC-Time for the corresponding charging rule (derived from CRD table) for that TDF-Application-Identifier 
and Sponsor-Id. After expiry of the rule, CPS uninstalls the rule and informs PCEF through a Gx RAR message.

As per the 3GPP specification, the Sponsored-Connectivity-Data AVP format is:

Sponsored-Connectivity-Data::= < AVP Header: 530 >

[ Sponsor-Identity ]

[ Application-Service-Provider-Identity ]

[ Granted-Service-Unit ]

[ Used-Service-Unit ]

*[ AVP ]

Where [Granted-Service-Unit] is a grouped AVP and contains CC-Time AVP. 

However, TDF can still send an Application Stop in CCR-U to communicate the rule expiry.

In case of Manifest rules, when CPS removes the default bearer rule and installs the dedicated bearer rule on receiving 
Application Start from PCEF, CPS updates the CC-Time for the dedicated rule and vice-versa (that is, when the dedicated 
rule is removed and default is installed).
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Platform

2 SILO Upgrade Support for ISSU
CPS now allows to maintain subscriber sessions during an upgrade and not redirect traffic to other sites during the 
upgrade. Application will be triggered to split the traffic to avoid any cross communication between the releases during 
ISSU process.

The new implementation will create two true isolated silos that will allow the traffic to stay constrained to one silo or the 
other during an upgrade. The VMs in the single CPS cluster (excluding the cluster manager VM) will still be divided into 
two sets as was done for previous releases:

 The diameter endpoints of the Policy Directors (lbs) will be fronted with HA Proxy.

 During an upgrade, the policy server (QNS) application will be configured to pull messages from the queue of only 
the Policy Director (lbs) in the silo not being upgraded

Current TLS Version Support and Control
CPS now supports all currently registered TLS versions from TLS 1.1 onwards. The configuration parameters for this 
feature are listed in the SecureConfig.csv configuration file.

Support for TLS 1.0 is disabled by default. However, in case of any external constraints preventing the disabling of TLS 
1.0, configuration parameters are available for use.

For more information, see CPS Installation Guide for VMware. 

Enhanced Self-healing of Cluster Manager
The critical CPS Cluster Manager processes are now managed using monit. Following are the processes:

 Apache Server (httpd)

 Orchestration-api-server

 Zookeeper

 Whisper

The log files can be found at /var/log/monit/monit.log.

For processes running on CPS versions prior to Release 10.0.0, the processes will be managed by monit once CPS is 
upgraded to CPS Release 10.0.0 or later.

New Sharding Commands in OSGi Console
CPS now has the following capabilities:

 Dynamically add or remove shards without impacting the application.

 Distribute the session migration among multiple Policy Servers (QNS).

 Rate limit the migration.

Following are the OSGi commands:

 listshards

 removeshard <shard id>
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 rebalance <rate limit>

 rebalancebg <rate limit>

 rebalancestatus

For a description of the above commands, see CPS Installation Guide for VMware.

Policy Director Split Brain Robustness
CPS can now handle the corosync split brain scenario that occurs when a connection loss occurs between two Policy 
Directors (Load Balancers) or two PCRF clients. The configuration parameters for this feature are listed in the 
Configuration.csv configuration file.

For more information, see CPS Installation Guide for VMware.

SNMP to Handle Threshold Based KPI Alarms
CPS can now generate SNMP alarms for KPIs after they have reached threshold values. The threshold values are 
configured in the /etc/broadhop/kpi_threshold.conf configuration file. The kpi_threshold.conf configuration 
file contains all the KPI scripts and must be configured to generate the KPI traps. The configuration file must be present 
on all VMs.

Events generated by KPI script are logged in the config.py log file. The following table defines the configuration 
parameters:

Traps generated are logged in the /var/log/snmp/trap file on the active Policy Director (LB).

Software Rollback
CPS now provides an automated process to rollback to the previous working release when an in-service software 
upgrade fails. 

For more information, see CPS Upgrade Guide. 

TACACS Server Reachability Diagnostic Check
A new option --tacacs has been added under diagnostics.sh command to check TACACS server reachability.

Table 3 Configuration Parameters

Parameter Description

GV_LOG_LEVEL= logging.INFO Log levels are as follows:

 1: DEBUG

 2: INFO

 3: WARN

 4: ERROR

GV_LOG_FILE="/var/log/broadhop/kpi-alarm.log Log file path and log file name.

GV_LOG_FILES=5 Number of log files to preserve.

GV_LOG_SIZE=10 * 1024 * 1024  #10MB Log file size.

GV_STATS_INTERVAL=300 Statistics collected during last 300 seconds.
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For more information, see CPS Operations Guide.

System Data Capture Utility
CPS 10.0.0 and later releases supports a new dump utility (dump_utiltity.py) which can be used to fetch information 
from the system in case of field issues. Field issues are broadly categorized as system issues, application related issues, 
and database related issues. For these issues, standard information, which is generally asked, is determined. This utility 
fetches such information from VM, depending on type of information and VMs selected in the input.

This utility can be executed from anywhere from the terminal. Logs are printed on terminal as well as stored in log file in 
/var/tmp/ directory. Log file name has the format dumputility-date_time_at_which_command_executed.log.

For more information, see CPS Operations Guide.

Platform Orchestration API

HTTPS Support for Orchestration API
CPS Cluster Manager can now be deployed with HTTP or HTTPS self-signed certificate mode. After Cluster Manager is 
deployed, you can modify the /etc/facter/facts.d/cluman_facts.yaml configuration file to use your trusted 
certificates.

For more information, see CPS Installation Guide for OpenStack.

Orchestration API Input and Output Formats
The CPS Orchestration API now supports both YAML and JSON formats for both inputs and outputs. For more 
information, see Orchestration API chapter of the CPS Installation Guide for OpenStack.

Policy Server and Session Manager Scale-up
This release introduces an API to increase the session capacity of the CPS cluster by deploying additional Policy Server 
(qns) and Session Manager (sessionmgr) VMs. Before issuing this API, the VMs must be created in OpenStack using Nova 
boot or Heat.

To add additional QNS and/or SessionMgr hosts to an existing deployment, issue a PATCH to the following URL:

http://<Cluster Manager IP>:8458/api/system/config/hosts

This API requires a YAML configuration file which defines the new hosts to be added.

This release also introduces an API to configure additional replica sets on newly deployed SessionMgr VMs. This API 
applies only for SESSION databases. 

To configure additional replica sets on newly deployed SessionMgr VMs, issue a PATCH to the following URL:

http://<Cluster Manager IP>:8458/api/system/config/replica-sets

This API requires a YAML configuration file which defines the replica sets to be added.

The status of this API call is reported in http://<Cluster Manager IP>:8458/api/system/config/status

Status logs are also written to: /var/log/startupStatus.log on the Cluster Manager VM.

API logs are written to: /var/log/orchestration-api-server.log on the Cluster Manager VM.

For more information about these APIs, see Orchestration API chapter of the CPS Installation Guide for OpenStack.
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Policy Builder Usability Improvement

Auto Save Policy Builder Configuration Changes
Old Behavior: Currently, Policy Builder (PB) user interface supports to automatically save changes made by you which 
you have not explicitly saved when you navigate to the next screen or close the window/tab so that changes made by 
you are not lost if they forgot to press the Save button.

This design allows for ease of use but has the unintended consequences that if you inadvertently made changes then 
those unintentional changes would be saved automatically unless you utilize the undo function to revert to the 
configuration before the accidental change occurred. 

New Behavior: CPS now supports a new checkbox (Expert Mode) which when checked will enable auto-save function 
and support the old behavior. This checkbox is available under Tools > Preferences. 

If Expert Mode checkbox is not selected, the following options are displayed while updating/creating/coping an object:

 Updating an Object: While updating an object the PB asks Do you want to save this object? with option buttons as 
OK and Cancel. If you click OK, the data being worked on is saved and if you click Cancel the data being worked 
on is not saved to the repository.

 Creating an Object: While creating an object the PB asks Are you sure you want to create this object? with option 
buttons as OK and Cancel. If you click OK, the new object is created with the default values and if you click Cancel, 
the object is not created.

 Copying an Object: While copying an object the PB asks Are you sure you want to copy this object? with option 
buttons as OK and Cancel. If you click OK, the object is copied and if you click Cancel, the object is not copied.

For more information, see CPS Mobile Configuration Guide.

Improved Service Options Readability
In Policy Builder, the Service Options label is moved to the top left of the table to indicate the table is for the list of service 
options.

For more information, see CPS Mobile Configuration Guide.
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Improved Usability for ANDed or ORed Initiators and Conditions in Policy Builder
The Policy Builder interface has been enhanced to clarify the underlying AND/OR logic when multiple initiators, 
conditions, or input variables are used together. For example, on the Use Case Template screen shown below:

 When multiple Services Initiators are added, ANY one of the listed initiators can be true for the Use Case Template 
to be used, as indicated by the caption “(OR Together)”

 When multiple Conditions are added, ALL of the conditions must be true, as indicated by the caption “(AND 
Together)”.

 When multiple Input Variables are added, ALL of the variables must be true, as indicated by the caption “(AND 
Together)”.

These captions are now used throughout the Policy Builder interface, including Use Case Templates, Use Case Options, 
Search Table Groups, Custom Reference Data Triggers, and Policies. 

For more information, see CPS Mobile Configuration Guide.

Improved Use Case Template Readability
In CPS 10.0.0 and later releases, Use Case Template and Use Case Option tabs have been renamed to Actions tab 
under Services. 
10
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Also, a new parameter -DshowUseCaseInitiatorTabFirst can be added in pb.conf (/etc/broadhop/pb/) file has 
to re-order the Use Case Template and Use Case Option tabs. By default, -DshowUseCaseInitiatorTabFirst is set 
to true (does not required to be added in pb.conf file by default). 

If set to true, Use Case Template and Use Case Option tabs will be displayed in order:

 Use Case Template: 

Use Case Initiators > Actions > Documentation: 

 Use Case Option: 

Use Case Initiators > Actions > Documentation:

For backward compatibility, the configuration parameter -DshowUseCaseInitiatorTabFirst in pb.conf 
(/etc/broadhop/pb) file will be set to false. Use Case Template and Use Case Option tabs will be displayed in order: 

 Use Case Template: 
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Use Case Template > Use Case Initiators > Documentation:

 Use Case Option: 

Use Case Option > Use Case Initiators > Documentation:

Option to Restrict Concurrent Policy Builder User Sessions
The following new parameter can be added to the /etc/broadhop/pb/pb.conf file on the server to restrict concurrent 
sessions to a limit:

-Dpb.user.session.limit

This is an optional parameter.

For more information, see CPS Advanced Tuning Guide which is an internal document and can be obtained from Cisco 
Representative.

Policy Builder Commit Message Persistence
Old Behavior: Currently, if we add an explanation in the Commit Message pane when we publish the configuration (File 
> Publish to Runtime Environment...) and if publish fails then the commit message is lost.
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New Behavior: CPS now supports to save the unpublished commit messages in a property file into the file system. This 
file is saved in the user directory under the selected repository location. For different users, PB will generate different 
property files.

PB saves the unpublished commit messages into the file system for the following cases:

 When loading Publish dialog box (when selecting File > Publish to Runtime Environment…) then saved commit 
message, if any, appears for that user in Commit Message pane.

 While publishing the policy configuration, if publish fails then the entered commit message is saved into the file 
system.

 While publishing the policy configuration, if publish succeeds then remove the message from file for the logged in 
user.

 If you click Cancel on Publish dialog box then the entered commit message is saved into the file system.

 If you click Cross (x) on Publish dialog box then the entered commit message is saved into the file system.

 When loading Saving to Repository dialog box (when selecting File > Save to Client Repository…) then saved 
commit message, if any, appears for that user in Commit Message pane.

 While saving to client repository, if operation fails then the entered commit message is saved into the file system.

 While saving to client repository, if operation succeeds then remove the message from file for the logged in user.

 If you click Cancel on Saving to Repository dialog box then the entered commit message is saved into the file 
system.

If you click Cross (x) on Saving to Repository dialog box then the entered commit message is saved into the file system.

For more information, see CPS Mobile Configuration Guide.

Policy Builder GUI URL - Session Id No Longer Transversed
The following new parameter is added in the /etc/broadhop/pb/pb.conf file on the server to fix SESSIONID addition 
in URL:

-Dorg.ops4j.pax.web.session.url=none

For more information, see CPS Advanced Tuning Guide which is an internal document and can be obtained from Cisco 
Representative.

Policy Builder Publish Error Notification
Old Behavior: Currently, sometimes the Publish operation fails due to errors in various data across the application. You 
do not get to know as to why the operation has failed as the errors are displayed on a per object basis i.e., if you go to 
any particular object screen, then only the respective error can be viewed along with the markers. Otherwise these errors 
are not visible to you while publishing/saving the data to the repository.

New Behavior: Publish functionality has been enhanced to include the list of unresolved errors in the GUI. The errors will 
be populated in a hashmap dynamically. For example, if an error is encountered in Gx Client as: The required feature 
'realmPattern' of 'default' must be set then the hashmap is set in the following key value pair:

<"Id", "String_of_errors">

where, “id” is the object's ID for which the error is coming on GUI and “String_of_errors” is the string containing all 
the errors with respect to the current object.
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The above hashmap is created in the session and is updated accordingly as the errors are resolved or are introduced 
newly with respect to their ID.

The format of error string is as: 

<Object_Name> <Feature_Name> :: <Error_String>

The errors are shown only for the objects which are not readonly.

You can select and copy one or more of the errors in the list and paste them into another window (for example, in an 
email or in a file to mask the acceptable errors).
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If you click OK with any unresolved errors in the list then you are prompted with a confirmation asking if the unresolved errors 
should be published to the repository. 

If you click No, then the publish does not happen. 

If you click Yes then the commit message is amended to include a note that you have committed with # errors. For 
example, “User forced the Publish with 3 unresolved errors: <user's commit message>”. 

Masking of errors: You can mask the errors if needed for a situation where an error is reported by PB but can still be 
loaded by the Policy Server. This allows configuration of CPS so that the specified errors are not displayed and you do 
not ignore the list of unresolved errors and the real errors are not lost amongst a list of acceptable errors. 

The file named maskPublishErrors.txt is created in the folder /etc/broadhop/pb on Cluster Manager (CM). After 
creating the file, run build_all.sh from CM to rebuild CPS package and push the changes to each VM. The file is 
populated with the exact message displayed in the GUI. No wildcarding is allowed (so as to prevent accidentally filtering 
out important messages). The GUI does not display any messages that are in the maskPublishErrors.txt file. The GUI 
does not count any messages that are in the maskPublishErrors.txt file. If all of the errors in the list are masked because 
they are in the file then clicking OK in the Publish dialog will not cause the Override dialog to be displayed.

For more information, see CPS Mobile Configuration Guide.

Policy Reporting

Counting Unique Active Subscribers
Policy reporting is enhanced by additional policy reporting field types for ANDSF as listed below:

 PolicyType

 devId

 LocationType
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 Location

 PolicyName

 PolicyUpdateCount

 authUserName

 devType

 clientName

 uuid

For more information, see CPS Policy Reporting Guide.

Service Orchestration API

API based Modification of CPS Cluster Configuration Parameters
This release introduces an API to update the parameters within the ‘config’ section of the consolidated configuration on 
the CPS cluster. 

To modify these parameters on an existing deployment, issue a PATCH to the following URL:

http://<Cluster Manager IP>:8458/api/system/config/config

This API requires a YAML configuration file which includes the parameters to be modified.

The status of this API call is reported in http://<Cluster Manager IP>:8458/api/system/config/status

Status logs are also written to: /var/log/startupStatus.log on the Cluster Manager VM.

API logs are written to: /var/log/orchestration-api-server.log on the Cluster Manager VM.

For more information about these APIs, see Orchestration API chapter of the CPS Installation Guide for OpenStack.

Online API Documentation (RAML)
The RAML documentation is updated to remove the following:

 /pb/servicedata/jsonservices

 /pb/servicedata/jsonservices/{id}

 /environment/core/threadingConfiguration

 /servicedata

 /referencedata

For more information, see RAML documentation:

AIO: http://<ip>:7070/doc/index.html

HA: https://<lbvip01>:7443/doc/index.html
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Policy Builder API Authorization Support
The following new parameter is added in the /etc/broadhop/pb/pb.conf file on the server to disable the authorization 
support in API:

-Dapi.repository.disableAuthorization

For more information, see CPS Advanced Tuning Guide which is an internal document and can be obtained from Cisco 
Representative.

Smart Licensing
Cisco Smart Software Licensing is a cloud-based approach to licensing, which simplifies the purchase, deployment, and 
management of Cisco software assets. Smart Licensing has been enabled for CPS for release 10.0.0, and is documented 
in the new “Smart Licensing” chapter in the CPS Operations Guide.

Installation Notes

Download ISO Image
Download the 10.0.0 software package (ISO image) from:

https://software.cisco.com/download/release.html?i=!y&mdfid=284883882&softwareid=284979976&release=10.0.0&
os=

Md5sum Details: 

e0406b3015cf6e6e5eb1ff5a60cd9940 CPS_10.0.0_Base.release.tar.gz

a492130d81cde2bbc1bb0b2cd4913242 CPS_10.0.0.release.iso

Component Versions
The following table lists the component versions for the CPS 10.0.0 Release: 

Table 4 Component Versions

Component Version

ANDSF 1.3.0.release

API router 1.2.0.release

Audit 1.8.0.release

Balance 4.1.0.release

CALEA 1.1.0.release

Cisco API 1.4.0.release

Cisco CPAR 1.4.0.release

Control Center 3.8.0.release

Congestion Reference Data 1.6.0.release

Core 10.0.0.release

CSB 2.1.0.release
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Installation Notes
New Installations
 VMware Environment, page 18

 OpenStack Environment, page 18

VMware Environment
To perform a new installation of CPS 10.0.0 in a VMware environment, see CPS Installation Guide for VMware. 

OpenStack Environment
To perform a new installation of CPS 10.0.0 in an OpenStack environment, see CPS Installation Guide for OpenStack.

Upgrading an Existing CPS Installation
To upgrade an existing CPS installation, see CPS Upgrade Guide.

Note: In-service software upgrades to 10.0.0 are supported only from CPS 7.0.5 or higher. If needed, upgrade CPS to 
7.0.5 before proceeding.

Note: In-service software upgrades to 10.0.0 are supported only for Mobile installations. Other CPS installation types 
(Wi-Fi, MOG) cannot be upgraded using ISSU.

Note: Currently, All-in-One (AIO) upgrades are not supported.

Custom Reference Data 3.1.0.release

DRA 1.2.0.release

DHCP 1.8.0.release

Diameter2 4.1.0.release

Fault Management 1.4.0.release

Hotspot 1.2.0.release

ISG Prepaid 2.2.0.release

LDAP 2.1.0.release

Notification 7.1.0.release

Policy Intel 3.1.0.release

POP-3 Authentication 1.8.0.release

RADIUS 3.7.0.release

Recharge Wallet 1.6.0.release

SCE 2.5.0.release

Scheduled Events 1.7.0.release

SPR 3.1.0.release

Unified API 3.1.0.release

Web Services 1.9.0.release

Table 4 Component Versions

Component Version
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Post Upgrade Steps

Re-apply Configuration Changes
After the upgrade is finished, compare your modified configuration files that you backed up earlier with the newly 
installed versions. Re-apply any modifications to the configuration files.

Verify Configuration Settings
After the upgrade is finished, verify the following configuration settings. 

Note: Use the default values listed below unless otherwise instructed by your Cisco Technical Representative.

Note: During the upgrade process these configuration files are not overwritten. Only during a new install will these 
settings be applied.

 /etc/broadhop/qns.conf 

-Dmongo.client.thread.maxWaitTime.balance=1200
-Dmongo.connections.per.host.balance=10
-Dmongo.threads.allowed.to.wait.for.connection.balance=10
-Dmongo.client.thread.maxWaitTime=1200 
-Dmongo.connections.per.host=5 
-Dmongo.threads.allowed.to.wait.for.connection=10 
-Dcom.mongodb.updaterIntervalMS=400
-Dcom.mongodb.updaterConnectTimeoutMS=600
-Dcom.mongodb.updaterSocketTimeoutMS=600
-DdbSocketTimeout.balance=1000
-DdbSocketTimeout=1000
-DdbConnectTimeout.balance=1200
-DdbConnectTimeout=1200
-Dcontrolcenter.disableAndsf=true 
-DnodeHeartBeatInterval=9000 
-DdbConnectTimeout.balance=1200
-Dstatistics.step.interval=1 
-DshardPingLoopLength=3 
-DshardPingCycle=200 
-DshardPingerTimeoutMs=75 
-Ddiameter.default.timeout.ms=2000 
-DmaxLockAttempts=3 
-DretryMs=3 
-DmessageSlaMs=1500 
-DmemcacheClientTimeout=200 
-Dlocking.disable=true 

Note: The following setting should be present only for GR (multi-cluster) CPS deployments:

-DclusterFailureDetectionMS=1000 

Note: In an HA or GR deployment with local chassis redundancy, the following setting should be set to true. By 
default, this is set to false.

-Dremote.locking.off 

 /etc/broadhop/diameter_endpoint/qns.conf

-Dzmq.send.hwm=1000
-Dzmq.recv.hwm=1000
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Reconfigure Service Option
After upgrading from previous release to the current CPS release, Service option configured with Subscriber-Id becomes 
invalid and customer needs to reconfigure multiple Subscriber Id in SpendingLimitReport under Service Configurations.

Additional Notes
The following section contains some additional notes which are necessary for proper installation/working of CPS:

 Session Manager Configuration: After a new deployment, session managers are not automatically configured.

a. Edit the /etc/broadhop/mongoConfig.cfg file to ensure all of the data paths are set to /var/data and not 
/data.

b. Then execute the following command from pcrfclient01 to configure all the replication sets:

/var/qps/bin/support/mongo/build_set.sh --all --create

 Default gateway in lb01/lb02: After the installation, the default gateway might not be set to the management LAN. If 
this is the case, change the default gateway to the management LAN gateway.

 CSCuz11476: Puppet fails to run and configure properly LB nodes other than lb01/lb02

During an upgrade to 10.0.0 the following changes are made to the folders and files on the Cluster Manager:

— The contents of /var/qps/current_config/image-map on the Cluster Manager is modified to consolidate 
the existing lb entries (lb01 and lb02) into a single lb entry (lb=iomanager).

— The existing /var/qps/current_config/etc/broadhop/iomanager01 and 
/var/qps/current_config/etc/broadhop/iomanager02 directories are consolidated into a single 
/var/qps/current_config/etc/broadhop/iomanager directory.

 CSCuq83478: Diameter haproxy configuration is not correct for IPv6 addresses.

Fix: IPv6 tables need to be turned OFF for IPv6 traffic on lb01, lb02. Management and IPv6 Gx traffic should be on 
different VLANs in VLAN.csv file at the time of deployment.

 CSCux20675: High message timeouts observed after qnsxx power on

Problem Description: High Timeouts observed when qnsxx is brought back into service/recovered after an VM 
outage.

Conditions/Scenario: Normal HA setup with call model running.

Workaround: Any recovery (blade/VM) should done during off-peak hour when other VMs CPU is < 50%.

 CSCuy23530: Receiving error msg while creating subscriber from SPR API

Conditions/Scenario: If clusterPeers flag is configured in /etc/broadhop/iomanager01/qns.conf file OR 
/etc/broadhop/iomanager02/qns.conf file in previous installation of CPS and you are upgrading to 9.1.0.

Apply Configuration Change: 

If clusterPeers flag is configured move the flag with same value to /etc/broadhop/qns.conf file 

OR 

If clusterPeers flag is not configured, add clusterPeers entry to /etc/broadhop/qns.conf file. Also remove 
clusterPeers entry from /etc/broadhop/iomanager01/qns.conf file and /etc/broadhop/iomanager02/qns.conf 
file.

Impact if above change is not applied:
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If clusterPeers flag is not moved to new location, cluster broadcast message will not happen.

Recommended: This change is highly recommended to be applied.

 CSCuz43943: Replacing SrcAddress and Port to any is not working

Problem Description: PCRF has no option to ignore SOURCE IP in AAR request and send ANY to PGW.

Conditions/Scenario: SOURCE IP is sent in flow description in AAR from the AF.

Workaround: Custom policy needs to be added in AF to replace the SOURCE IP in flows to ANY before sending it 
to PCRF. 

 CSCuz44551: Usage Monitoring key AVP sent in GX RAR when no Usage monitoring needed

Problem Description: Usage Monitoring key AVP is sent out in Gx RAR in case no Usage monitoring is required.

Conditions/Scenario: The Monitoring key AVP is sent even if the usage monitoring is enabled/disabled for 
sponsored data use case.

Workaround: This issue has no adverse effect as monitoring key without monitoring information in Gx RAR is ignored 
by PGW.

 CSCuy82522: Incorrect config file on system leads to SSH blocked after upgrade

Problem Description: SSH is blocked on Installer

Conditions/Scenario: The /root/.ssh/config file is modified duing install.sh which blocks ssh

Workaround: The /root/.ssh/config file is modified as below which blocks ssh. 

[root@C_installer .ssh]# cat /root/.ssh/config
StrictHostKeyChecking=noUserKnownHostsFile=/dev/null
LogLevel=quiet

Manually change to:

[root@C_installer .ssh]# cat /root/.ssh/config
StrictHostKeyChecking=no
UserKnownHostsFile=/dev/null
LogLevel=quiet

 CSCuy82546: custom config file results in HTTPD process unable to start after ISSU

Problem Description: ISSU upgrade fails with errors:

http://installer/rpms/quantum/qps/x86_64/repodata/repomd.xml: [Errno 14] PYCURL ERROR 7 - "couldn't 
connect to host"
Trying other mirror.
Error: Cannot retrieve repository metadata (repomd.xml) for repository: QPS-Repository. Please 
verify its path and try again
You could try using --skip-broken to work around the problem
You could try running: rpm -Va --nofiles --nodigest

Starting httpd: Syntax error on line 1 of /etc/httpd/conf.d/reqtimeout.conf:
Invalid command 'RequestReadTimeout', perhaps misspelled or defined by a module not included in the 
server configuration

[FAILED]

Conditions/Scenario: The httpd process is unable to start.

Workaround: Check if /etc/httpd/conf.d/reqtimeout.load is present. 
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If it is, edit /etc/httpd/conf.d/reqtimeout.conf and add Include conf.d/reqtimeout.load as the first line 
of the file. For example:

[root@installer cluman]# cat /etc/httpd/conf.d/reqtimeout.conf
Include conf.d/reqtimeout.load 
RequestReadTimeout header=10-20,minrate=500
RequestReadTimeout body=10,minrate=500

 CSCuy82570: 2nd attempt to run install.sh script aborts automatically

Problem Description: The install.sh script aborts itself.

Conditions/Scenario: The file /var/qps/install/current/release-train-7.5.1.tar.gz modified to 
/var/qps/install/current/release-train-9.0.0.tar.gz during the first failed run of install.sh.

Workaround: Rename the file back to /var/qps/install/current/release-train-7.5.1.tar.gz and rerun 
install.sh. 

 By default, pending transaction feature is enabled. If you are not using it, Cisco recommends to disable pending 
transaction feature post deployment. 

To disable pending transaction, the following parameter can be configured in /etc/broadhop/qns.conf file: 

com.broadhop.diameter.gx.pending_txn.attempts=0

After adding the parameter in qns.conf file, restart all VMs.

 If TPS is high, user needs to disable “STA”. To disable STA, user needs to create custom policies. For more 
information, contact your Contact Technical Representative.

 CSCuz59023: CPS should not allow non-root users to check sudosh logs.

Problem Description: TACACs users that do not have superuser privileges can access all the files on the systems 
and some of the files (sudosh logs) contain sensitive data. Currently read-only/admin users can read the sudosh 
logs.

Conditions/Scenario: User having qns-ro/qns-admin role.

Workaround: A log reader utility has been implemented so that non-root user will not be allowed to view the sudosh 
logs.

Users (qns-ro, qns-admin) are allowed to view logs files at specific paths according to role and maintenance 
requirement. User are able to access logs via only white listed path. As per current configuration /var/log/, 
/var/log/broadhop/scripts/, /var/log/httpd, /var/log/redis, /var/log/broadhop paths have been 
white listed. There is no recursive access implemented. Hence any new/sub directory needs to be white listed 
separately.

User will not be able to execute cat, less, more, find commands using sudo anymore.

For reading any file, user needs to execute the script using sudo. 

$  sudo /var/qps/bin/support/logReader.py -r h -n 2 -f /var/log/puppet.log

-r allowed t,tf,h which corresponds to tail,tailf and head respectively 
-n this is optional parameter. No. of lines to be read this works by joining the with -r option.
-f complete file path to be read. 

Support reading gunzipped files is also available.

 CSCuz87423: qns entries in haproxy.cfg is only 4 but configured qns is 16.

Problem Description: Puppet adds entries for only four policy server (qns) only in /etc/haproxy/haproxy.cfg 
on lb01/02 if user configures more than four policy server (qns) instances.
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Limitations and Restrictions
Conditions/Scenario: When the user configures haproxy_qns_instances value equal to actual policy server (qns) 
instances which are greater than four in Configurations.csv file.

Workarounds: 

Workaround 1:

1. Replace the following line in /var/qps/install/current/puppet/modules/qps/manifests/haproxy.pp file

if( ( $::haproxy_qns_instances ) and ( $::haproxy_qns_instances < $::qns_instances ) ) {

with

if( ( $::haproxy_qns_instances ) and ( $::haproxy_qns_instances <= $::qns_instances ) ) {

2. Run build_puppet.sh script from Cluster Manager to rebuild puppet.

3. Run /etc/init.d/vm-init from both lb01 and lb02.

Workaround 2:

Add entries for total number of qns instances manually into /etc/haproxy/haproxy.cfg file on both lb01 and 
lb01.

Limitations and Restrictions
This section covers the following topics:

 Limitations, page 23

 Common Vulnerabilities and Exposures (CVE), page 24

Limitations
 If you have a system with the old installer (6.1 or prior), it is mandatory to use the new installer to create VMs and 

use the new release trains. The latest 9.0.0 release train does not work with the old environment (AIO/HA).

 Solicited Application Reporting

The following are some restrictions on configuration for the new service options:

— The pre-configured ADC rule generated by CRD lookup has ADC-Rule-Install AVP definition with support for 
only three AVPs ADC-Rule-Name, TDF-Application-Identifier, Mute-Notification.

— For AVPs which are multi-valued, CRD tables are expected to have multiple records - each giving the same 
output.

— Comma(,) is not a valid character to be used in values for referenced CRD column in SdToggleConfiguration.

— AVP Table currently only supports OctetStringAvp value for AVP Data-type.

 During performance testing, it has been found that defining a large number of QoS Group of Rule Definitions for a 
single sessions results in degraded CPU performance. Testing with 50 QoS Group of Rule Definitions resulted in a 
2x increase in CPU consumption. The relationship appears to be a linear relationship to the number of defined QoS 
Group of Rule Definitions on a service.

 Hour Boundary Enhancement

Change in cell congestion level when look-ahead rule is already installed:
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CDETS
If a cell congestion value changes for current hour or any of the look-ahead hours, there will be no change in rule 
sent for the rules which are already installed.

No applicability to QoS Rules:

The look-ahead works for PCC rules only where we have rule activation/deactivation capabilities and can install 
upcoming changes in advance. However, if the RAN Congestion use case is changed to use the QoS-Info AVP 
instead of using PCC rules, we need to fall back to the current RAR on the hour boundary implementation for that 
use case since the standard do not let us install QoS-info changes ahead of time like we can with PCC rules. 

 The Cluster Manager's internal (private) network IP address must be assigned to the host name “installer” in the 
/etc/hosts file. If not, backup/restore scripts (env_import.sh, env_export.sh) will have access issues to OAM 
(pcrfclient01/pcrfclient02) VMs.

 The linux VM message.log files repeatedly report errors similar to:

vmsvc [warning] [guestinfo] RecordRoutingInfo: Unable to collect IPv4 routing table.

This is a known issue affecting ESXi 5.x. Currently, there is no workaround. The messages.log file entries are 
cosmetic and can be safely ignored. For more information, refer to 
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=2094561

 CSCva02957: Redis instances will continue to run, even after redis is disabled using the parameter 
-DenableQueueSystem=false in qns.conf (/etc/broadhop/) file and /etc/broadhop/redisTopology.ini 
file.

 CSCva16388: A split brain scenario (that is, VIPs are up on both nodes) can still occur when there is connectivity 
loss between lb01 and lb02 and not with other hosts.

Common Vulnerabilities and Exposures (CVE)
The following is the list of publicly known Common Vulnerabilities and Exposures (CVE) apply to this version of CPS:

 For OpenSSL:

— March 2016 Vulnerabilities: 
https://tools.cisco.com/security/center/content/CiscoSecurityAdvisory/cisco-sa-20160302-openssl

Currently, only two medium vulnerabilities out of March 2016 incident (CVE-2016-0703 and CVE-2016-0704) are 
open. Rest of the OpenSSL issues have been fixed in this release.

 Pacemaker v1.1.10 Vulnerability (CVE-2013-0281):

Pacemaker contains a vulnerability that could allow an unauthenticated, remote attacker to cause a denial of service 
condition on a targeted system. The vulnerability exists because the network socket used by the affected software 
fails to close a remote connection after a certain period of inactivity. An unauthenticated, remote attacker could 
exploit this vulnerability by connecting to the Pacemaker socket. When connected, the socket may wait for an infinite 
amount of time to perceive the authentication credentials, which could allow the attacker to block all other 
connection attempts, causing a DoS condition for legitimate users.

CDETS
The following sections lists Open CDETS and Resolved CDETS for Cisco Policy Suite. For your convenience in locating 
CDETS in Cisco’s Bug Toolkit, the caveat titles listed in this section are drawn directly from the Bug Toolkit database. 
These caveat titles are not intended to be read as complete sentences because the title field length is limited. In the 
caveat titles, some truncation of wording or punctuation might be necessary to provide the most complete and concise 
description. 

Note: If you are a registered cisco.com user, view Bug Toolkit on cisco.com at the following website:
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CDETS
https://tools.cisco.com/bugsearch

To become a registered cisco.com user, go to the following website:

https://tools.cisco.com/RPF/register/register.do?exit_url=

Open CDETS
The following table lists the open CDETS in the CPS 10.0.0 release.

Table 5 Open CDETS

CDETS ID Headline

CSCuz16739 CPS should use bound Gx session instead of first one found for ASR/RAR

CSCuz70453 CPS: qns engine logs are not getting logged

CSCuz82321 Receiving “Skipping message due to queue overload” in cons..... qns log

CSCuz92894 Can't delete subscribers when balance replica set not in sm01 and sm02

CSCuz94110 Parallel VM creation fails

CSCva06624 Two callbacks are coming where there is no RAR received within timeout.

CSCva06854 GC (Allocation Failure) error is coming frequently due to high CPU at LB

CSCva07114 ZMQ connectivity degrades performance for REDIS calls

CSCva08274 Unified API Benchmarking test fails

CSCva08972 CPS: Response timeout for sendSMSNotification(Primary) is seen

CSCva12324 CPS installation guide misses balance backup DB details

CSCva12827 Dedicate rule get installed on RAT_CHANGE from UTRAN to EUTRAN

CSCva14277 Rollback.py stalls and Time Sync failure during 10.0 to 9.1.0 rollback

CSCva14326 Sessionmgr02 switches to secondary for session set 2 after rollback

CSCva14368 GR- Site-2 is not processing the requests when isolated from site-1

CSCva18606 top_qps.sh does not shows newly added qns using API

CSCva22105 [ISSU-7.5.1 -- > 10.0] Grafana dashboards un-recoverable after upgrade

CSCva23258 SITE: Inconsistent behavior seen while executing command using shell.

CSCva27006 CPS 10.0- taileng never prints auth app id avp (258)

CSCva28816 PB-Diameter Agents - not allowing to create more than one default Agent

CSCva28926 session_cache_ops.sh --db-shrink fails due to time out

CSCva29160 [Rollback 7.5.1 -- > 10.0] SPR nodes not available after rollback

CSCva34673 License logs “lmgrd log” are not getting generated in AIO

CSCva35431 High response time for diameter messages using Consumer Model CRDs
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Resolved CDETS
The following table lists the resolved/verified CDETS in the CPS 10.0.0 release.

Table 6 Resolved CDETS

CDETS ID Headline

CSCut85211 Cisco Policy Suite Confidential Information Disclosure Vulnerability

CSCuu13030 collectd is being restarted on periodic basis

CSCuv93615 CPS: In AIO, default staging port for Policy Reporting Config wrong

CSCux20241 LDAP thread exception on sprint 9 and LDAP connections down

CSCux20675 High message timeouts observed after qnsxx power on

CSCux50114 Grafana 503 service not available when pcrfclient01 is booting

CSCux87992 CPS: Admin login SNMP traps are logged to the /var/log/snmp/trap file

CSCuy01339 diagnostic is showing error: spr_site1 SPR node is not available

CSCuy02773 TACACS+ prompt for password multiple time while executing diagnostic.sh

CSCuy07295 CPS does not override Monitoring-Key for Sponsored Connectivity Data

CSCuy07668 Evaluation of qps for OpenSSL January 2016 Vulnerabilities

CSCuy09503 set_prioirty shows ERROR on mongo 3.2.1 setup

CSCuy09568 storageEngine takes default wiredTiger and not mmapv2 in mongo 3.2.1

CSCuy12790 CPS Prime Analytics Integration Patch 1

CSCuy16980 CPS: Datbase restore is not working with export and import command

CSCuy18980 Fix issue with collectd exec scripts.

CSCuy20663 Evaluation of Cisco Policy Suite for NTP January 2016 Vulnerabilities

CSCuy22480 CCR % dropped alarms after 7.5.1 upgrade

CSCuy23167 /var/qps/bin/support/recover_svn_sync.sh is giving SVN init failed msg

CSCuy23887 High response time from CPS causing timeouts

CSCuy28261 A corrupt RADIUS request is proxied if NAS-IPV6-Address AVP is included

CSCuy29610 migrate_primay.sh shows 'No local upgrading DB Member' on 3.2.1

CSCuy32665 Stopping internal interface on standby SM causes 50+ ms lock times

CSCuy33229 Session recovery feature to recover charging rules, event-triggers, QoS

CSCuy42128 cps is retrying message with incorrect destination host name and realm

CSCuy42998 Garbage value printing in about.sh and change_passwd.sh

CSCuy45481 Missing LOOP init

CSCuy47811 OpenStack HA ISSU from 8.1 to 9.0 build 383 failed

CSCuy48629 In case of POST/PUT/DELETE api request callback token is missing

CSCuy50631 ISSU failed with error as Arbiter is down

CSCuy50810 Observed 'Sync Policy Action' errors during ISSU 9.0

CSCuy51595 Evaluation of Cisco Policy Suite (CPS) for glibc_feb_2016 vulnerability

CSCuy53376 redis port 6379 is not opened in iptables

CSCuy54069 OpenStack-10.0 and OpenStack-9.0-HA-UpdateQPS failing

CSCuy55204 Receiving 5003 error intermittently while creating static Gx-Sh session

CSCuy55435 SIMless E911 call is rejected by CPS

CSCuy55640 LicenseManagerProxy errors is being observed on qns vms logs.
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CSCuy56030 Session objects are not stored in session after CCA-i

CSCuy57096 Error while running diagnostics.sh and about.sh

CSCuy57558 POLICY RESULT ERROR: null error for several subscribers

CSCuy57579 ISE 1.4 upgrade to 2.0 Endpoints Purge Activities Alarm showing error

CSCuy57688 Two CoA Sent to ASR9K when Accounting Start request is received

CSCuy58611 Intermediate SLRs seen when identifier list is removed from SLR template

CSCuy61944 Execution of qps_vip_init.sh script failed during fresh install on OSP

CSCuy62700 ISSU scripts should pause to fix Whisper failures during the upgrade

CSCuy63720 Sh Retry on CCR-u not working

CSCuy64039 Intermittent AF App Id validation failures after system recovery

CSCuy64071 chkconfig not checking sessionmgr processes

CSCuy65060 CRD Data entry error after schema change

CSCuy65119 Updated Override Controls not sent after PNR profile change

CSCuy65191 Error in recovering cluster manager

CSCuy69067 mon_db_for_callmodel not monitoring reporting properly

CSCuy69267 Support for DB shrink option with session_cache.sh script

CSCuy70411 CPS sends SyPrime messages to wrong peers

CSCuy71332 Issue observed with Configuration...

CSCuy72384 Sh Retry Race Condition Not working, CCR-u before CCR-i retries finishes

CSCuy73085 mongodb.MongoExpirationQuery - Session expiry fail with exception

CSCuy73600 CPS - Gx-RAR not getting generated intermittently.

CSCuy74227 CPU usage above 80% in 9.0 longevity

CSCuy75798 traps were thrown to /var/log/messages in Active LB In CPS 9.0

CSCuy77635 PBJ link should not be displayed in about.sh and CPS Central page

CSCuy78736 NPE in Rx NDM on Gx RAR timeout (NetLoc/Ran-Nas-Cause feature enabled)

CSCuy79301 Super tenant password exposed in log and should not have default value

CSCuy79618 Platform: Orch API log can grpw unbounded during error conditions

CSCuy79699 Query of Sessions based on imsi in case of LTMI should return 0 records

CSCuy79831 Auth CDR is getting corrupted in failure scenario

CSCuy81067 PCRF sending SGSN_IPV6_ADDRESS value with only Prefix value in Sy-AAR

CSCuy81068 QPS_deployment_config spreadsheet only supports 4 networks

CSCuy81135 PCRF including IMS default bearer values in GX-RAR for an AUDIO call

CSCuy82102 Remove IPv6 from STR in case ANGW has only IPv4 address

CSCuy82196 Firewall rules are enabled even when firewallState is set to “disabled”

CSCuy82522 Incorrect config file on system leads to SSH blocked after upgrade

CSCuy82570 CPS 9.0- 2nd attempt to run install.sh script aborts automatically

CSCuy82647 diagnostics.sh waits on checking basic ports for too long

CSCuy84851 on qns/session VMs mongoauth iptable rules getting deleted alternatively

Table 6 Resolved CDETS

CDETS ID Headline
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CSCuy86937 Radius Accounting Proxy is not happening for Multiple OCS

CSCuy87721 ISSU upgrade was failed due to missing package on CM VM

CSCuy88070 Failure to handle exceptions in mongo backup and mongo init.d scripts

CSCuy88082 Called Station Id AVP not picked upon receiving CCR-U

CSCuy88129 LDAP: Existing dedicated bearer is not deleted after MIND revalidation

CSCuy88992 Override control missing in CCA-U message during Session sync

CSCuy89013 Error scenario for Sd Application Start event

CSCuy89336 qns-ro user shows redis FAIL (root/qns show PASS)

CSCuy90491 Consolidated Syslog is not failing over to pcrfclient02

CSCuy95931 diagnostics.sh shows wrong result for haproxy when executed by qns user

CSCuy96208 CDR's are not generated for Time and Volume usage reported in CCR-T

CSCuy97102 lb accepting request after both the sessionmgr of siteA are down

CSCuv44231 CPS is not sending RAR towards AF if receive NetLoc-Access-Support AVP=0

CSCuz01165 max wait time fix

CSCuz03453 Hit Not Found errors when trying to export service configuration

CSCuz03479 Big Bang Init Script Controls Horizon Console

CSCuz04680 LAC retriever failure

CSCuz06602 puppet error on arbiter installation on third site

CSCuz07228 Old SGSN IP still stored in the session when new value is reported

CSCuz07864 puppet error during patch installation

CSCuz09298 Some config.csv values missing from Orch API yaml config

CSCuz11301 Platform: Whisper logs taking up 20+GB of space during error conditions

CSCuz11473 env_export.sh does not export the CRD when only --mongo-crd flag is used

CSCuz11476 Puppet fails to run and configure properly LB nodes other than lb01/lb02

CSCuz13043 ISSU: During ISSU after VM reboot pcrfclient puppet fails at grafana

CSCuz17289 reset user location fields (cgi, tai, etc.) when user location change

CSCuz18955 mongo_stat.sh does not terminate when collectd does

CSCuz21008 Upon LDAP timeout/down during refresh installed rulebase removed

CSCuz23015 CPS Service API commit message issues.

CSCuz24743 Sd DIAMETER_REALM_NOT_SERVED

CSCuz25759 change_passwd using md5 instead of sha-512

CSCuz26118 RPC services are running on pcrfclient VMs

CSCuz27894 didn't allow write access to PB for the new users, created by adduser.sh

CSCuz28044 Monitoring Key 3e8 not being set correctly in CCA-i

CSCuz29220 R9 AIO spams the log with mongo_stat.sh empty list of mongo hosts error

CSCuz29693 CPS is not binding Rx session with Gx session when IMSI_APN set

CSCuz30033 /var/log/broadhop/scripts logs cleanup needed via rotation.

CSCuz32893 Intermediately monit process is in dead state in one of the VM's

CSCuz33082 ISSU fails on system that has been deployed using Orch API
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CSCuz33298 DiameterDeviceMgr when DiameterRequestMessage is not present

CSCuz34346 High Load Recovered issue in SNMP clear traps

CSCuz35033 Changes to HidingAvp

CSCuz36657 /etc/broadhop/pcrf/mcc.xml should be a part of AIO fresh install/upgrade

CSCuz39057 QPS - LB /var/log/snmp/trap log filling VM's disk space

CSCuz40332 CDET for handling zero scenario in PB for SCTP & TCP mode.

CSCuz40491 PCRF not installing default charging rule after dedicated rule removal

CSCuz40494 High latency observed during qns reboot due to puppet and java Init

CSCuz41197 Issue in env_import.sh script

CSCuz43943 Replacing SrcAddress and Port to any is not working

CSCuz44551 Usage Monitoring key AVP sent in GX RAR when no Usage monitoring needed

CSCuz47594 Not receiving error code in GET when session is in error

CSCuz50399 Unable to scale beyond 12k

CSCuz50527 CDRs timestamp format is different from 6.1 release

CSCuz54460 Gx-RAR should not be sent if Rx-STR received before RanNasRetry Timeout

CSCuz55697 Medium HTTP Server Prone To Slow Denial Of Service Attack [FID 12824]

CSCuz57440 “Auth-Session-State” AVP missing in UDR message.

CSCuz58698 Destination-Host AVP is missing in RAR retry messages

CSCuz59023 CPS should not allow non-root users to check sudosh logs.

CSCuz59963 CDR zip file is showing multiple .gz .gz .gz suffix

CSCuz60291 Showing incorrect grafana stats for CDR, during reporting db down

CSCuz60427 java.lang.NullPointerException found during 12 hrs longevity

CSCuz61388 Recurring Bill Cycle quota reset amount

CSCuz62187 Issue related to TLS DH Key Exchange Logjam Vulnerability post 7.5

CSCuz65730 Upgrade taking more time in production  HA setup.

CSCuz68354 not able to observe trap: /home for disk space

CSCuz68985 ISSUP CPS 9.0 vm reboot process hung during the upgrade

CSCuz70244 Sh Timeout issue when UDR is returned with result Code 7000

CSCuz71906 com.mongodb.CommandFailureException observed in GR setup

CSCuz75368 Duration in QosDefine API request should be in seconds

CSCuz77466 Error in AIO in build_etc.sh during upgrade

CSCuz81524 collectd does not work on Zing, so on lb we need Zulu

CSCuz84027 logback file log level changes requires qns restart

CSCuz84622 Update logstash configuration files in puppet framework

CSCuz84679 CPS restart fails if no SVN

CSCuz85384 LB's and QNS vm's not getting down after the shutdown of all the SM's

CSCuz85408 NullPointerException is observing during stress testing.

CSCuz87423 qns entries in haproxy.cfg is only 4 but configured qns is16
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CDETS
CSCuz87966 set_priority.sh script doesn't support IPv6

CSCuz87968 apply API fails on license install when admin db members are on IPv6

CSCuz89019 Differences in diagnostics.sh output between TACACS user and Root User.

CSCuz89506 MOTD (message of the day) missing on cluster manager VMs

CSCuz89642 CPS status API failure

CSCuz89644 /api/system/mongo/action/addMembers fails on replication network

CSCuz90935 Observing discriminant sy transaction Id for Sy-AAR and Sy-STR

CSCuz92566 CPS: Many Timeouts, 5012 and 5002 failures seen for Solution1 test case

CSCuz94132 Endpoint Starts as Local Host__Incorrect Session ID

CSCuz94178 After QNS process, LDAP queries are dropped.

CSCuz94285 Gx session binding is not happening when IP address is set

CSCuz97265 IMP/EXP & Service Orch API vulnerabilities found by IBM App Scan

CSCuz97408 App Stop/Start event trigger should get decoupled from TDF-App-Id on Gx

CSCuz98183 Number of Gx-RAR for uninstallation of rule is very less

CSCuz98397 License errors in diagnostics output of latest CPS 10.X master builds

CSCuz98505 Call Trace Utilities do not Work as Expected

CSCuz98881 OpenStack scale setup can't handle 15K tps

CSCva00035 10.0 rollback: logback/xm and publishRepositories.xml changes

CSCva00040 10.0 rollback: user data not retained

CSCva00527 CPS 10.0 ISSU rollback py error in restore original script

CSCva01130 Auto-recovery of mongo Replica Sets freezed on a failure

CSCva01149 Cutter Log file has Zero bytes

CSCva03006 Out file not generated for dump utility unless absolute path specified

CSCva03810 ReplicationRunner.getMsgSla() needs default value of 500 milliseconds

CSCva03917 ISSU failed on OpenStack - while executing inservice_upgrade.sh

CSCva03949 Licensing doesn't throw traps or diagnostic errors upon breach

CSCva05585 2SILO Upgrade: Set-1 LB should start taking diameter calls after upgrade

CSCva05923 iomanager memory leak at com.broadhop.activemq

CSCva07134 FUA Rules are being sent incase of Subscriber Data is cached in USuM.

CSCva08955 Not able to establish association for SCTP only on AIO

CSCva11090 ISSU from 8.1 to 10 hangs

CSCva11249 Rollback: Wrong log dir input to quiesce action leads to error trackback

CSCva12853 CPS install the rule for which CC-Time already expired after RAT_CHANGE

CSCva12869 Next Eval Time is not set to CC-Time after RAT_CHANGE

CSCva13201 Session Recovery is not happening after session is removed from database

CSCva13625 9.1 to 10.0 SILO OpenStack ISSU - Unable to Open Grafana

CSCva15648 9.1 to 10.0 SILO OpenStack ISSU - qns04 Upgrade issue

CSCva17296 Enable SL with new entitlement tags

CSCva20632 gen-ldap-trap.log files are not getting purged periodically.
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Related Documentation
Related Documentation 
This section contains information about the documentation available for Cisco Policy Suite.

Release-Specific Documents 
Refer to the following documents for better understanding of the Cisco Policy Suite.

 CPS ANDSF Configuration Guide

 CPS Backup and Restore Guide

 CPS CCI Guide for Full Privilege Administrators

 CPS CCI Guide for View Only Administrators

 CPS Geographic Redundancy Guide

 CPS Installation Guide - OpenStack

 CPS Installation Guide - VMware

 CPS Mobile Configuration Guide

 CPS Operations Guide

 CPS Policy Reporting Guide

 CPS Release Notes

 CPS SNMP, Alarms, and Clearing Procedures Guide

 CPS Troubleshooting Guide

 CPS Unified API Reference Guide

 CPS Upgrade Guide

 CPS Wi-Fi Configuration Guide

The documents can be downloaded from the following links:

 All Guides

http://www.cisco.com/c/en/us/support/wireless/quantum-policy-suite-bng/products-installation-and-configurati
on-guides-list.html

CSCva21530 Cluster Set file getting updated with Junk Logs

CSCva21565 High Response time - ZMQ to REDIS SILO ISSU

CSCva24137 Error found during upgrade of FCV candidate ISO.

CSCva28627 Rollback: enable action restore original script in wrong directory
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Related Documentation
 Mobile Configuration Guide: 
http://www.cisco.com/c/en/us/support/wireless/quantum-policy-suite-mobile/products-installation-and-configur
ation-guides-list.html 

 Wi-Fi Configuration Guide: 
http://www.cisco.com/c/en/us/support/wireless/quantum-policy-suite-wi-fi/products-installation-and-configurati
on-guides-list.html 

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and 
gathering additional information, see What’s New in Cisco Product Documentation.
To receive new and revised Cisco technical content directly to your desktop, you can subscribe to the What’s New in 
Cisco Product Documentation RSS feed. The RSS feeds are a free service.
Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other 
countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks 
mentioned are the property of their respective owners. The use of the word partner does not imply a partnership 
relationship between Cisco and any other company. (1110R)

This document is to be used in conjunction with the documents listed in the Obtaining Documentation and Submitting a 
Service Request, page 32 section.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses 
and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in 
the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative 
content is unintentional and coincidental.

© 2016 Cisco Systems, Inc. All rights reserved.
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